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Introduction to Macintosh
Course Description: This class provides an overview for the beginning Macintosh user who has little or no prior
computer experience. Topics covered include identifying components, working with the menu bar,
understanding the concepts of the Macintosh operating system, and file management.
Prerequisites:  No previous computer knowledge or experience is required for this class.

GETTING STARTED

At Home
If you are using an older Macintosh computer (Mac), such as the Mac Classic or SE, in which the
computer is a single unit of both monitor and CPU (Central Processing Unit), there will be a single
power switch located in the back (on the left side).  If you are using a newer Mac, such as any in the
Centris, Performa, and PowerMac series, in which the monitor is separate from the CPU, there will be a
separate power and monitor switch.  We recommend you turn the power switch on before the monitor
switch when turning your computer on, and vice versa when shutting the computer down.  This will
save the screen from excessive power surges.

At Workstations and Microcomputer Facilities (W&MF)
To use a Mac in the campus computer facilities you must first obtain a facility use account; this
account must be renewed each semester.  To get an account, simply speak to a consultant on-duty at any
of the campus facilities.  You will need to present your student of faculty ID when creating an account.
Once you have a facility use account, you can log in to any available Mac or PC in the computer
facilities.  The log in screen will prompt you for your SID (student ID) number and your password.

NOTE:  This account enables you to use the computers within the facility.  It is not an e-mail
(electronic mail) account.  Ask a consultant on-duty how to sign up for a separate e-mail
account.
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TERMS AND DEFINITIONS

Hardware - the physical pieces of machinery that make up the Mac computer
•Hard drive -- a large capacity storage unit for programs and files, which is located in the CPU
•Server -- similar to a large hard drive, but used for a number of computers on a network
•Disk drive -- for the use of information stored on a disk; goes into action when you insert a disk
•Disk -- (a.k.a. "floppy disk") a portable storage device that is inserted into the disk drive metal side

forward, with the circular metal piece on bottom
High density (HD) -- holds 1.4 MB of memory.  Only runs on newer computers (it will not run

on Mac SE, only computers with “SuperDrives”).
Double density (DD) -- holds 0.7 MB (800 K) of memory (1/2 as much as high density).  Can be

read by all Macs.

FYI:  How much information can I fit on my disk?
•One page of text in word processing is approximately 7 K
•1000 K = 1 Megabyte (a.k.a. Meg or MB)

•CD-ROM -- holds 660 MB of memory.  Operates much like a regular (audio) CD, but can store
computer data as well.  CD-ROMs are often contain software from a manufacturer or are used
with multimedia software that combines audio, visual and hypertext elements in one interface.

•Mouse -- used to move around the screen and select what you want to change or work with.
Movements of the mouse correspond with movements of the pointer on the screen.  Anything you
wish to do on the screen is directed by the mouse (except for typing).

Point and click -- place the mouse pointer directly on top of any icon, window, or text on the
desktop and click once to select it

Double click -- to start a program, place the mouse on top of the program icon and click the
mouse twice quickly

Drag and drop -- to move a window or icon from one place to another on the desktop, place the
mouse on top of the icon, hold the mouse button down as you drag the mouse across the
screen; release the mouse button once the icon has reached the desired position

Software - the programs/applications on the Mac
•Word processing -- word processing programs allow the user to compose papers, résumés, etc.

Table and/or graphing functions are available on some word processing programs.  Graphics and
pictures can be "imported" and placed in documents.
Examples:  Microsoft Word, WordPerfect

•Spreadsheets -- spreadsheet programs allow the user to produce projections, calculations, and data
analysis.  They can store, manipulate, calculate, analyze data, and can also create charts and
graphs.
Example:  Microsoft Excel

•Graphics -- graphic (drawing or painting) programs allows the user to create pictures, boxes,
circles, textures, freehand drawings from the very simple to the extremely involved.
Examples: SuperPaint, ClarisDraw

•Publishing -- publishing programs allow the user to create newsletters, banners, desktop publishing,
move or rotate text, incorporate pictures, import text files, create guides, and columns anywhere
on the page, and make simple graphics.
Example:  Aldus PageMaker

•Networking -- network programs allow the user to access the internet, servers, email accounts, and
tranfer files between computers (File Transfer Protocol or FTP)
Examples:  NCSA Telnet, Netscape Navigator, Gopher, Eudora Pro, Fetch
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•Database -- database programs allow the user to keep and update multiple records within files that
you customize; useful for invoicing, address books, etc.
Example:  FileMaker Pro

•Integrated -- integrated programs allows the user the option of doing word processing, drawing,
painting, communication, spreadsheet, and database all in one simple to use program.
Example:  ClarisWorks

UNDERSTANDING THE DESKTOP

Once the computer has been turned on (or you have logged in), there will be a few moments in which
the computer is constructing the desktop.  The desktop is the management area or working environment
where documents, files, and programs are displayed.  Similar to a real desk or work area, it has a trash
can, a file cabinet (of sorts), and various tools and resources for organizing and storing information.
The small pictures you see on the desktop screen are called icons.  Icons represent files, applications,
documents, disks, and folders.

Using the Mouse
The tool that you will use most often on the desktop is the mouse.  Most mice are attached to the
keyboard by a cord.  Mac laptops have mice that are imbedded in the keyboards and look like a movable
ball or are touch sensitive pads.  Both types work in the same way.

The mouse will usually appear on the screen as a pointer: or cursor: .  To select an item, put the
pointer tip directly on the icon and click the button once.

To open an icon double click on the icon with the mouse.

Window control
If you double click on a disk or folder, a window will open displaying its contents (as shown above).  In
this case, we opened “untitled folder,” there is one item in the disk, “Intro to Macintosh,” and there is
152.3 MB left to use in the disk.  There are scroll bars on the bottom and right side of the window, that
let you scroll left, right, and up and down if there are many things in the window.  The first box in the
upper right hand corner allows you to shrink and expand the window to a set specification.  The second
box in the upper right hand corner allows you to shink the window to just the title bar, thus allowing
you to see objects underneath.  The box in the lower right hand corner allows you to resize the window
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to your desire.  The box in the upper left hand corner will close the window if you click once.  If you
place the mouse on the title bar (the six horizontal lines at the top of the window) and hold the mouse
down, you can drag the window to any place on the desktop.

Menu bar

The menu bar is the bar at the top of the screen that allows you to perform special commands.  It
changes for every program you run, as different applications have different abilities.  If the words are
bolded, then it is possible to use the function. If the words are gray, then the function cannot be used
with what is selected.

Each of the commands in the menu bar represents a pull-down menu.  When you click and hold the
mouse button down while it is over a given command in the menu bar, a menu appears ("pulled down"
like a window shade) with a list of command options.  Drag the mouse down and release the button
when the desired option is highlighted.

UNDERSTANDING THE DESKTOP (continued)

Apple Menu Items
The Apple Menu is at the far left of menu bar.  It controls
much of the functionality of the Mac.  The most important
functions under the Apple menu are the Chooser and the
Control Panels.  The Chooser allows you to change things
that are connected to your Mac, such as the printer or server.
Control Panels allow you to change the Mac environment.
You can change the time, date, monitor settings, keyboard
sensitivity, mouse sensitivity, and much more.  Try selecting
Key Caps and hold down the Option key on your keyboard.
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File Menu
The File Menu can be used to create New Folders to organize files in
your hard drive or on your disk.  It can Open, Close, or Print
applications, files, or windows.  You can Get Info about any icon on
the desktop, such as what kind it is: MS Word file, desktop folder,
etc., when it was created, and how much memory it is using.
Duplicate allows you to make a copy of something, simply select
what you want to copy by clicking once on its icon then go to the File
Menu and select Duplicate.  Find may help you locate something if
you know the name but don’t know where it is.

NOTE:  The "clover-like" symbol to the right in the menu bar
represents the Command key.  You will see a similar
symbol and an Open-Apple key on your keyboard next to
the space bar.  You can perform the same functions listed to
the left with a simple key-stroke command.  For example,
holding down the “Command key” and “N” at the same time
will give you a New Folder in the active window.

UNDERSTANDING THE DESKTOP (continued)

Edit Menu

The Edit Menu allows you to Undo the last thing you did, Cut and Copy
something and Paste it somewhere else.  It allows you to Clear a
selection, Select All of what is selected and show what is currently on the
Clipboard.

NOTE:  The Clipboard is a temporary holding area for the Mac.
Whenever you cut some text or an image from the screen, it
does not disappear, it is moved to the clipboard until you need
to paste it somewhere else.
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View Menu

The View Menu allows you to determine how you would like your
windows to display your files.  You can choose to display your files as
Icons, buttons or lists.  You can also select the way your window is
displayed.  Under the Arrange sub menu, you can choose to sort your
files by name, date, size, etc.

Special Menu
The Special Menu allows you to keep your windows organized.  Clean
Up Window will make the icons, in a selected window, snap into a grid-
like pattern.  Empty Trash will delete the contents of the Trash Can. To
Format or Initialize a new disk, select Erase Disk.  To properly Restart
or Shut Down your machine, choose the appropriate option.

NOTE:  Be sure to check the contents of the Trash Can by double-
clicking on the Trash Can icon before you empty it.

The Help Menu provides information that helps you learn more about
how to use the Macintosh OS.  The Show Ballons feature will create help
ballons that give you a short description of many items on the desk top.
The Help feature provide a lot of information, and sometime even step to
step instructions for many of your computing needs.
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UNDERSTANDING THE DESKTOP (continued)

Macintosh HD
This icon represents the “Macintosh Hard Drive” -- not to be confused with High
Density.  This is where the System Folder (which holds all the Apple specific
programs). On your home computer, programs would be stored on the Macintosh
HD. In the ocmputer facilities, the Lost and Found folder is stored on the hard
drive.

Programs Icon
To the left is the Programs Icon.  This is where W&MF holds all its software
programs for you to use. All the software programs are organized into folders
according to program types, such as word processing, spreadsheet, and networking.

Trash Can Icon

  

Once you decide to throw something away, whether the data is obsolete or you need
to free disk space, just drag and drop the item into the trash can.  The item is not
actually gone until you go to the Special Menu and select Empty Trash.  To the
left, you can see the difference between when the trash can is empty and when it is
not.  The trash can on the left is empty, and the trash can on the right contains items.

NOTE:  The Trash Icon can also be used to eject your disk -- it will not erase your disk.  To
eject your disk, just drag the disk icon to the trash can and the disk will spit out of the
disk drive.
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UNDERSTANDING THE DESKTOP (continued)

Finder

The finder is represented by a small computer icon that appears in the upper-right hand corner of
your screen. The finder is similar to the program manager that exists on PCs. The finder allows thge
user to hide programs that are currently not in use or to switch to a different opened program with a
simple click of your mouse button (this is called multi-tasking).  Even though there are no windows
open on the desktop, programs may still be running in the background.  Always check the finder to see
if a program is still open.

This is what the finder will look like if you are currently in Microsoft
Word 6.0.1a, while also running Netscape Navigator 4.05 in the
background.  When the application (program) is active, the finder
appears as the program icon, instead of the little computer icon we
saw above.  Dragging the mouse down and releasing on top of
another program would select that program and your window will
change accordingly.  This is very helpful if you want to run several
applications at the same time.

OTHER FUNCTIONS OF THE DESKTOP

Formatting A Disk
If you are using a new disk, it will need to be formatted.  When you insert it in the disk drive, it will
prompt you to Initialize or Eject.  Choose initialize and whether it is a High or Double Density disk (the
outside of the disk will indicate whether the disk is High or Double Density), and Initialize.  If you want
to re-initialize a disk that has already been initialized, then choose Erase disk from the Special menu.
You may also use this to change the format of your disk from PC to Mac or vice-versa.  Reformatting a
disk will erase all data previously stored on the disk.

Quitting A Program
If you are finished with your work and wish to quit out of the program you were using, simply go to the
File Menu and pull down to the Quit option.  This will shut the program down and return you to the
desktop screen.  If you were in the middle of work and have not saved your input, the program will ask
if you would like to save.  If this happens, simply click the appropriate box before closing the program.

Ejecting A Disk
To eject your disk, drag the disk icon into the trash can.  This will not erase your files, and is actually
the best way to eject a disk.  Other ways include: Eject disk from the Special menu or Put away from
the File menu, but these will leave a trace of the icon on the screen.  If you cannot eject by dragging
into the trash, hit the keys shift, command (or open apple key), and 1 all at the same time.  If you
continue to have problems ejecting your disk, or your disk is stuck, contact a consultant on-duty to assist
you.

Logging Out
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At the Microcomputer facilities, it is very important to log out every time you’re finished with your
work.  Find the Facility Logout icon and double click.  This will log you out correctly and prevent
other clients from using your account.


